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LOGO! in detail – slide overview

The LOGO! in detail slides are split into 3 parts as follows:

• LOGO! in detail, part 1

Installation and overview of the function blocks

• LOGO! in detail, part 2

Operation on the device and handling of the software

• LOGO! in detail, part 3

Knowing how
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Track signals more easily2

LOGO! and KNX: Just try it3

Efficiently use message texts4

Program the web server with LOGO! Soft Comfort5

Monitor wire breaks with LOGO!6

Highlight connecting lines in color7

Preface1

LOGO! in detail – agenda
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LOGO! in detail – preface

LOGO! in detail, part 3, is intended to give the reader useful tips and tricks for using 
Siemens LOGO!, which often are unknown even to experienced users. This relates to 
the features within LOGO! Soft Comfort and the possibilities with LOGO! itself. 

All screenshots were taken of the current version of LOGO! Soft Comfort.

The download can be found at the following 
https://w3.siemens.com/mcms/programmable-logic-
controller/en/logic-module-logo/demo-software/Pages
/Default.aspx
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LOGO! in detail – track signals more easily

When testing larger programs, one problem often arises: 
Where are the signals coming from?
And where do they go?

LOGO! Soft Comfort gives users a better overview in a number of ways.
Thanks to the clear user interface, signals can be understandably depicted graphically, and 
supplemented with comments.
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LOGO! in detail – track signals more easily

Let’s first take a look at the cut connection before 
block B096.

The signal comes from block B016 on the same 
page, otherwise the page would also be indicated in 
the identifier, e.g., 5/B016, if the block is found on 
page 5 of the diagram. 

But what kind of signal is it?
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With a right mouse click on the symbol B016, a window opens, 
and by selecting “Go to partner”, ... 

LOGO! in detail – track signals more easily

... the user automatically arrives at the source of the signal. 
There, you have to orient yourself and identify the function of 
the signal.

8/30/2018Page 7



Unrestricted © Siemens AG 2018

LOGO! in detail – track signals more easily

A quick overview is obtained in a simple way:
By giving the function blocks, located at the 
respective connections, a name in 
their block properties. These are accessed by 
means of a double-click on the desired function block, 
or by a right-click → “Block properties”.

Afterwards, the blocks and connecting lines are labeled 
with the just assigned names. To the extent 
that relevant and meaningful names have been 
assigned, one immediately gets an indication of what 
the signal means.
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LOGO! in detail – track signals more easily

For the easy signal tracking over longer distances, the 
connecting lines can be depicted colored. 
To do so, select the “Marking of lines” icon.

The selected lines are then depicted colored, and can 
be traced easily even across pages.

If a function block is selected, all connections to it are 
depicted in another color.
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LOGO! in detail – track signals more easily

But it is also possible to label the connections to a function 
block. Several options are 
available to do this.

A simple way is via the comment field in the 
block properties. 
(Right-click on function block → “Comment”.)
Here, for example, “Motor ON”.

In doing so, the comment must then be moved 
before the block.  The font size should be adjusted 
so that text exactly fits between the input 
lines. 
(Right-click on comment → “Font”.)
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LOGO! in detail – track signals more easily

For general explanations, the use of a text block 
lends itself. The font, size and color are user-definable 
almost endlessly.
(Right-click on comment → “Font”.)

Text blocks (“Insert comment field”        ) can also be linked
to function blocks or connection symbols.

To do so, drag the centered yellow square onto the 
desired block. Once connected, it also moves with the 
symbol in the diagram.
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LOGO! in detail – track signals more easily

Furthermore, for the general functional description of the 
program, the menu item “File” → “Properties” → “Comment” 
allows a detailed description of the program to be made, 
e.g., to provide guidance to service technicians.

This option is also very helpful, if a more 
complex program needs to be adapted again after 
a long time.
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LOGO! in detail – track signals more easily

When printing the project ("File" → "Print"), this 
comment appears on a separate page, sort of like 
a cover sheet. (To do so, the checkbox at “Comment” 
of the content to be printed needs to be checked.)

With relatively little effort, a program can thus be 
better documented and understood, or retraced.
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With the new CMK 200 module for the connection to the building system bus KNX together with 
selected KNX devices, LOGO! 8 offers a very flexible automation solution that affords customers 
many benefits and a lot of convenience at a reasonable cost, and also can be easily adapted 
to changing space usage later on.

In the following, one method of exchanging data between 
LOGO! 8 and other KNX devices is briefly described. 
The number of providers of KNX devices is very large, which 
is why only the basic configuration of LOGO! 8 on KNX is illustrated here.

LOGO! in detail – LOGO! and KNX: Just try it
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The following is required for a successful start:
▪ LOGO! Soft Comfort demo version: www.siemens.de/logo-demosoftware
▪ ETS5 demo version: www.my.knx.org (free-of-charge, registration required)

Both software products are available for free on the Internet.

For the configuration of CMK2000, the KNX device software can be found at 
the following address: www.siemens.de/gamma-td?te2=CMK2000

Alternatively, the complete product catalog is available:
https://www.hqs.sbt.siemens.com/cps_product_data/data/produktdb_de.htm

LOGO! in detail – LOGO! and KNX: Just try it
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The communication between the LOGO! 8 basic unit and the KNX module CMK2000 
takes place over Ethernet. Compared to previous versions, this brings significant advantages:
▪ 50 freely configurable communication objects
▪ Maximum degree of expansion of LOGO! can be utilized
▪ Logical links and time and analog functions can also be used within the LOGO! 

program

In the following application example, knowledge of LOGO! programming is assumed.
Accordingly, the focus is on the connection to KNX.

LOGO! in detail – LOGO! and KNX: Just try it
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1. Transfer binary signal from LOGO! 8 to a KNX device
2. Transfer binary signal from a KNX device to LOGO! 8, and integrate it into the LOGO! program

As an example, a fan is to be controlled via an on/off delay.

LOGO! in detail – LOGO! and KNX: Just try it

In LOGO! Soft Comfort, one cannot initially see whether a KNX module is connected or not. Depending on 
the application, a telegram to KNX can be directly triggered by either the input (for this, the input does not 
even have to be used in the LOGO! program) or the output (should several links be contained, also via a flag 
in the program).
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If you open the ETS software and create a new project, the “Devices” view is recommended 
for beginners. The LOGO! device with CMK2000 must be inserted into the initially blank project.

LOGO! in detail – LOGO! and KNX: Just try it
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In order to use CMK2000 in ETS, the appropriate product database must first be imported 
into ETS. This single knxprod file can be downloaded from:
www.siemens.de/gamma-td?te2=CMK2000.

As already mentioned, the entire KNX product catalog can also be downloaded (see page 16).

But beware, there are different predecessors. The file shown here must be imported.

After the import, the CMK2000 module is displayed in the product catalog and available for 
further use in the project.

LOGO! in detail – LOGO! and KNX: Just try it
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The CMK2000 module must now be added to the project with “Add Device”. It will then 
be displayed in the device list. 

Selecting the module in the list and then the “Parameters” tab at the bottom accesses the basic 
settings of the CMK2000 module.

LOGO! in detail – LOGO! and KNX: Just try it
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It is important to enter the IP addresses of the LOGO! basic unit and CMK2000. 
In the example, the default addresses are kept. For the time being, the other 
settings are meaningless.

Now, a communication object for the data exchange must be defined, e.g., for channel 1.
Selecting it and specifying the transfer direction from LOGO! to KNX will open up the selection 
for the data type. In our example, the digital input I1 is to be used.

LOGO! in detail – LOGO! and KNX: Just try it
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As in the LOGO! program, the input I1 is selected; the default data type matches the signal.

Next, the communication object for channel 1 depicted is assigned to a group
address. To do so, click on the “Group address” field on the line of the communication object,
(1) select “Link with” (2) and assign a new group address with a suitable name (3).
The signal within the group address is then connected to the communication object of an actuator
on KNX.

LOGO! in detail – LOGO! and KNX: Just try it

1

2

3
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If a switching signal from a KNX device is to be processed in LOGO!, the communication 
direction selected must be the opposite.

Here, flag 10 in LOGO! is controlled via channel 2 (1). 
The program is then in LOGO!.

This corresponds to the previously configured program, only the input was replaced by the flag 
configured in ETS (2).

LOGO! in detail – LOGO! and KNX: Just try it

1
2
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Analog signals are handled in a similar manner. It would, however, be beyond this 
scope to list all possibilities. Here, we will show the simplest setting, where the analog input does
not have to be used in the LOGO! program. Only the transfer of the value at the terminal of the
analog input to KNX is activated. And vice versa, the transfer from KNX to LOGO! 8.

LOGO! in detail – LOGO! and KNX: Just try it
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When transferring from KNX to LOGO! 8, the value must be integrated into the program for 
further processing via an analog flag.

In the example, the heater is switched on at low temperatures. The heater is 
switched off above 200 (unscaled value here, LOGO! works with analog values from 0 to 1000).

A detailed description can be found in the application examples on the LOGO! pages at
https://w3.siemens.com/mcms/programmable-logic-controller/en/logic-module-logo/application-
examples/Pages/Default.aspx

LOGO! in detail – LOGO! and KNX: Just try it
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LOGO! in detail – Efficiently use message texts

For the modernization of conventional controllers, logic modules are often used.
In addition to a simple configuration and flexibility, they also offer options for visualization and 
operator guidance by means of a text display. Besides the output of text messages, including 
texts with actual values, other, often unknown, solutions are possible.
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The display integrated into LOGO! 8 accommodates 6 lines with 16 characters each, the external 
TDE even 20 characters per line (1). If the ticker function is used, the content of a message can 
be expanded to 32 or 40 characters per line (2).

LOGO! in detail – Efficiently use message texts

For (2): For messages configured via the TDE, 6 lines with 20 characters each are 
available. The ticker function doubles the characters per line.

For (1): Configuration of a message for the basic unit without ticker text 
(6 lines with 16 characters each).1

2

8/30/2018Page 27



Unrestricted © Siemens AG 2018

LOGO! in detail – Efficiently use message texts

The backlight can be switched in three colors. This allows messages 
to be structured according to:
▪ Standard with white background
▪ Warning with orange background
▪ Alarm with red background

In programs migrated from previous versions of LOGO!, the operator guidance can be revised to 
an even more convenient solution with just a few minutes of programming effort.
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LOGO! in detail – Efficiently use message texts

Keeping an eye on alarm messages

The features of the message text function block offer cost-effective operating and monitoring 
options that require little effort. Sporadic alarms, which only occur briefly, are often not detected, 
since nobody is looking at the display during these short periods of time. If these remain 
unnoticed, major disruptions can develop. Here, the acknowledgment function provides a 
remedy. It causes the message to remain displayed on the basic unit or external display (TDE) 
until it is acknowledged by pressing the OK button. This is true even if the alarm trigger, e.g., an 
excessive temperature value, has returned to the normal range and the alarm thus no longer is 
active. 

By means of the date and time, it can be depicted when the alarm was triggered. A counter can
also evaluate how often the alarm has occurred in the meantime.
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Summarizing messages

The character set function can be used to summarize 
two messages in the diagram. It would thus be possible 
to display the message in two languages depending on 
the operator. By activating flag 27, the two messages 
can be toggled.

About the figure: A second character set has been 
activated. The switching takes place via flag 27.

LOGO! in detail – Efficiently use message texts
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LOGO! in detail – Efficiently use message texts

The message in the second character set may also contain additional information for servicing 
that is not relevant to the operator. Actual values (analog or counter values) cannot only be 
displayed as a numerical value, but also as a vertical or horizontal bar graph. That usually makes 
the message clearer. 

In the past, two separate message texts 
were necessary to display the message 
“Motor ON” or “Motor OFF”, which were triggered 
depending on the output signal. 
Now, up to four status messages can be 
summarized in one message text.
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Depending on the input or output states, it is possible to “switch over”, which saves a lot of resources 
and makes the program clearer. 

LOGO! in detail – Efficiently use message texts

Even the outputs of individual function blocks can be used 
to trigger these status displays. 
In LOGO! 8, it is possible to design larger area symbols.
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Web server enables plant monitoring by smartphone

A highlight of LOGO 8! is the integrated web server. After connecting LOGO! 8 to a cost-effective 
WLAN access from a specialist shop, a plant can be monitored and controlled by 
smartphone or tablet, without the need for HTML programming. The basis for this again
is the message text. For this purpose, the web server is also selected in the depiction.

The message will then also be displayed on a smartphone.

LOGO! in detail – Efficiently use message texts
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LOGO! in detail – Efficiently use message texts

If provided for in the program, it can also be directly controlled on the smartphone via 
function keys. Following the program download, the web server access must be enabled 
directly in LOGO 8 and be password protected. From the end device, such as a smartphone or
tablet, the function keys can then be used, regardless of whether a TDE is connected to the
hardware or not. 

For example, shutters can be opened or closed as part of 
a building services application. (Here, the depiction on a 
smartphone, tablet or PC.)

8/30/2018Page 34



Unrestricted © Siemens AG 2018

LOGO! in detail – Program the web server with LOGO! Soft 
Comfort

The configuration of the web server is very easy via LOGO! Soft Comfort V8 –
completely without HTML programming knowledge.

There are several preconfigured views in the web server:
▪ LOGO! system
▪ LOGO! tags
▪ LOGO! BM (basic module)
▪ LOGO! TDE (external text display)

The first two provide system information and selected parameters. With the basic module, message 
texts seen on the basic unit can be displayed (figure).
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LOGO! in detail – Program the web server with LOGO! Soft 
Comfort

With the text display, message texts seen on the 
external display can be displayed, and in addition, 
the four function keys can be used.

The function keys must be meaningfully
integrated into the program beforehand via 
LOGO! Soft Comfort – so that the execution of the 
function is ensured.
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LOGO! in detail – Program the web server with LOGO! Soft 
Comfort

The views are adapted to the respective sizes of smartphone, tablet or PC, and can be depicted 
on all current browsers. 

1. Connect LOGO! 8 to the router.
2. Program a message text for LOGO! 8 or for a text display (TDE).
3. Text release for LOGO! 8 display, LOGO! 8 TDE or both. Activate the “Message text” function 

block (check-mark the web server with a mouse click – finished!).
1. Load the program into LOGO!.
2. In LOGO! 8, enable the access via the web server and assign a password (see also 

bottom figure on previous slide).
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LOGO! in detail – Monitor wire breaks with LOGO!

If an analog sensor transmits the value 0 to the controller, you do not know whether the value is 
actually 0 or the sensor is defective. In such cases, sensors can be used that normally output a 
current signal between 4 and 20 mA. If the controller recognizes a signal at the analog signal that
is significantly below 4 mA, then it can be assumed that the sensor or the sensor cable to the 
controller is defective.

▪ Use of an AM2 expansion module for the evaluation of signals in the range from 0 to 10 V 
and/or 0/4 to 20 mA.

▪ In the analog function block, select 4-20 mA as sensor.
▪ Insert an analog threshold switch, which triggers an alarm message or controls the 

desired behavior of the plant in case of signals below 4 mA, e.g., deactivate the defective area
and alert the operator or send an SMS to the service technician.
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LOGO! in detail – Monitor wire breaks with LOGO!

Example: Pressure of a water pipeline system is to be kept constant with a 
variable-speed pump.

Implementation: 
▪ LOGO! 12/24 RC as basic unit with AM2 expansion module with the analog inputs 

AI3 and AI4. 
▪ PI controller with LOGO! program. 
▪ Pressure sensor for 0-4 bar, delivers values 4-20 mA. Target pressure: 2 bar. 
▪ The system is to detect a wire break of the sensor, and in this case, display an alarm signal 

and an error message.
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LOGO! in detail – Monitor wire breaks with LOGO!

Programming the controller
▪ Switching between manual and controller operation 

with input I1.
▪ Sensor: 4-20 mA, scaling 0-4.000 with three 

decimal places (this generates values from 
0 to 4 bar displayed in the message text).

▪ Target value: 2.000, corresponds to 2 bar.
▪ Drive pump in manual mode with fixed value of 

100 (this corresponds to 10% of the maximum 
value = 1 V).

Caution: In the simulation, no wire break can 
be generated.
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LOGO! in detail – Monitor wire breaks with LOGO!

Constant overlay of the basic values on the 
display
▪ A message text with the target and actual values of
the pressure, and the actual value for driving the pump 
is to be constantly displayed. The actual values are to 
be depicted as value and bar graph.
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Tip: By activating the ticker text for lines 
3 and 4 as “line by line”, the 3rd and 4th lines in 
the message text will alternately display a service
telephone number as additional information 
to the date and time.

LOGO! in detail – Monitor wire breaks with LOGO!

Wire break monitoring with alarm message
Insert another analog threshold switch followed by 
an alarm output and alarm message text.

Sensor: 0-20 mA, to also evaluate values below 
4 mA (range 0-4 mA corresponds to 
input units 0-200, i.e., input signals in this range must
not occur during proper sensor operation).
Switch-on value of 0 und switch-off value of 200.
Switching of output 4 in case of a wire break, 
activation of an alarm message with the date and
time of the fault.
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LOGO! in detail – Monitor wire breaks with LOGO!

Constant activation of the display backlight

▪ For the better readability of messages, the backlight 
of the display, starting with LOGO!
0BA6, can be switched via the M25 flag or be 
constantly activated via the basic settings on the 
device. 

▪ With LOGO! 0BA7, the depiction on the 
integrated LOGO! display can be followed during 
the online test.

Caution: For the alarm message, the 
acknowledgment function was activated, i.e., 
after the fault has been eliminated, this must be 
confirmed with the “OK” button.

8/30/2018Page 43



Unrestricted © Siemens AG 2018

LOGO! in detail – Highlight connecting lines in color

LOGO! Soft Comfort offers many possibilities to make the work easier. It is often necessary 
to analyze programs where signals need to be traced across several project pages.
Having a good overview is very important with complex programs to be able to make 
adjustments. In LOGO! Soft Comfort, the connecting lines can be highlighted in color for this.

By emphasizing the color of the connecting lines, the desired connection can always be traced 
despite scrolling between pages, and the associated program sections be determined.
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LOGO! in detail – Highlight connecting lines in color

As an example, a larger program covering 
several pages is selected.

To highlight the lines, the following 
icon must be selected:
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LOGO! in detail – Highlight connecting lines in color

A simple click with the left mouse button on the desired 
connecting line suffices to trace it from beginning to end.

Sc
ro

ll
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LOGO! in detail – Highlight connecting lines in color

Alternatively, function blocks can 
also be selected, whereby their entire 
connection (inputs as well as outputs) 
is highlighted in color.

Tip: By holding down the CTRL key, 
several function blocks can be selected.
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LOGO! in detail – Highlight connecting lines in color

Under “Tools → Options → Colors”, all highlighted lines (1-12) 
can be color-adjusted or personalized. For the factory setting, 
the “Default” button is provided.

1

2

3
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LOGO! in detail – LOGO! Access Tool

The LOGO! Access Tool is an add-in for Microsoft Excel. It establishes a connection to the LOGO! 
basic module. Data from LOGO! 8 are read and displayed in an Excel table during operation.
The user can save the process values in a log file. The security during the connection between
LOGO! and the PC is ensured through the use of a web server password.

The free Access Tool allows the desired files to be displayed in the Excel file and then 
saved on your PC in the form of a CSV file, thus arching them. 
The tool can be used with any version starting with LOGO! 8, and does not require LOGO! Soft 
Comfort on the PC employed.

Summarized possibilities with the LOGO! Access Tool: 
Reading of data during operation, data configuration and archiving of data.
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LOGO! in detail – LOGO! Access Tool

The LOGO! Access Tool has many applications

Fields of application:
Test devices (safety check)
Energy consumption
Temperature characteristic curves
Food industry (cold chain monitoring)

Advantages:
Archiving of data during runtime (RUN)
For analyzing data on the PC
Archiving production data
Quality assurance
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LOGO! in detail – LOGO! Access Tool

The download of the free tool is available at the 
following link. 
After the download, the zip file must be unpacked 
and the add-in integrated into Excel. 
Proceed as follows:

Sc
ro

ll

Unzip2

Download1
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LOGO! in detail – LOGO! Access Tool

1

2
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The add-in is added by clicking on “Browse” and
then selecting “LOGO!AccessTool.xlam”
(stored in the selected folder of the unzipped file).

If the “LOGO!Accesstool” checkbox is checked 
(usually done automatically), confirm with “OK”.

LOGO! in detail – LOGO! Access Tool

1
2
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LOGO! in detail – LOGO! Access Tool

1

2

To link the Access Tool to LOGO!, Excel must be open. Select the “Add-ins” tab       .
Click on the drop-down menu and select “Log in”      . A window opens in which the IP 
address of LOGO! as well as the configured web server password must be entered      .
LOGO! should then be connected to the PC using the Access Tool.

3
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LOGO! in detail – LOGO! Access Tool

1

The data types supported can be found in LOGO! Soft Comfort or the documentation of the 
Access Tool. The values of the defined tag table (VM) can be displayed during the run of 
LOGO! in an Excel cell, if LOGO! is connected to the Access Tool.

2
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LOGO! in detail – LOGO! Access Tool

To display a value in Excel, enter the command “= LOGVAR(“ID”)” in the desired cell. Afterwards, 
“ID” must be replaced by the identification of the LOGO! tag. It consists of the tag type and the 
index, e.g., analog input 1 “AI1”. If, e.g., the value of a flag is to be determined in the Excel table, 
then “= LOGOVAR(“M1”)” must be entered for this, where 1 can assume the number of the flag 
from 1 to 64. LOGO! also supports tags with multiple indexes, as in the case of a shift register. If 
a specific bit of a tag is to be read, e.g., the 2nd bit of the 3rd shift register, the entry is 
“= LOGOVAR(“SR3.2”)”.

In the case of a tag memory, the ID “VB450” is defined. The index can assume a value between 
0 and 850.

Tag types are updated every second.
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LOGO! in detail – LOGO! Access Tool

To archive data in a log table, the command in Excel 
must be extended by an extra “L” (see figure on the 
left – orange “L”). The CSV file is then automatically 
saved in the higher-level folder of theopen Excel file.
The name of the CSVB file consists of the name of 
the xls file, the IP address as well as the date and 
time. 

If the open Excel file has not yet been saved, the log 
file is automatically stored in the “My Documents” 
folder of the active Windows user.
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LOGO! in detail – LOGO! Access Tool

To read data from LOGO! and display them in Excel, a 
corresponding program must run in LOGO!. This example 
illustrates the transfer of values from LOGO! using the 
LOGO! Access Tool in Microsoft Excel. This diagram 
represents an example of a temperature or pressure 
value, a fill or meter reading, or similar. You can 
download the sample program and test it yourself by 
transferring the program to LOGO!.

The program can also be reenacted as part of a web-based training. The WBT can be found at 
the following link (“Frist steps with LOGO!”). 
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LOGO! in detail – LOGO! Access Tool

After the program has been transferred to LOGO!, a 
password for the web server access must be assigned 
(“Tools"  → " Transfer"   → "Access control"). In the 
section “Web server access”, the web server access 
must be enabled, and at remote access, a password 
of your choice can be assigned.
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LOGO! in detail – LOGO! Access Tool

In LOGO! Soft Comfort, you can automatically call 
up all possible tags under “Tools”  → “Parameter VM 
assignment” and then "Block", and thus see the 
address of the tag. You must later specify this in Excel 
as part of the tag name. In this program, we specify 
the two bars under “Block” and thus receive the 
Indexes 0 and 2 – so that we can enter “VW0” and 
“VW2” as the ID for the capture in Excel. For the 
analog input, “AI1” as per the table from the Access 
Tool documentation is specified.
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LOGO! in detail – LOGO! Access Tool

After the Access Tool is available as an add-in in Excel, a 
connection between PC and LOGO! must be established. 
For this, select the tab “Add-ins” → “LOGO!AccessTool” 
“Log in” in Excel. After entering the IP address of LOGO! 
and the previously set password, the connection is 
established.

HOWEVER!
An Ethernet connection between LOGO! and PC is 
required.
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LOGO! in detail – LOGO! Access Tool

For a better overview, the tags should be labeled 
accordingly. To read in the data, the respective
command must be written into the cells. 
In this example, the tag name “VW0” must be entered
for the first bar.
The values of the second bar are determined with 
the tag name “VW2”. In this case, the potentiometer
is an analog input and has the tag name “AI1”.
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LOGO! in detail – LOGO! Access Tool

For a better overview, the tags should 
be labeled accordingly. To read in the 
data, the respective command must be 
written into the cells. In this example, 
the tag name “VW0” must be entered 
for the first bar. The values of the second 
Bar are determined with the tag name 
“VW2”. In this case, the potentiometer is 
an analog input and has the tag name 
“AI1”. Diagrams, for example, can be 
created from the read in data.
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Subject to changes and errors. The information given in this document only contains general descriptions and/or performance features which may 
not always specifically reflect those described, or which may undergo modification in the course of further development of the products. The requested 
performance features are binding only when they are expressly agreed upon in the concluded contract.

All product designations, product names, etc. may contain trademarks or other rights of Siemens AG, its affiliated companies or third parties. 
Their unauthorized use may infringe the rights of the respective owner.


